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How Stata Works 
 
Types of Files 

(1) Stata Executable 
Contains the compiled program that is the core of Stata. Ends in .exe. This is the file that 
runs when you open Stata.  

 (2) Ado files  
Programs that use features in the executable to add new commands to Stata. Visit 
stata.com/statalist for user written add-ons. You may also view the add-ons currently installed 
with the command… 

 
. ado dir  
 

 
 
 
File Storage 
Where are Stata files stored on your computer? Find out with the sysdir command.  

 
STATA: contains the executable.  
[Remaining directories contain ado-files and are referred to as ado-path.]  
BASE: official directory for ado-files written by StataCorp that were placed there during initial 
 installation. 
UPDATES: updates for ado-files created by StataCorp since installation.  
SITE: directory for ado-files that were installed by your site administrator.  
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PLUS: directory for unofficial ado-files (not distributed by StataCorp) you’ve installed.  
PERSONAL: directory for ado-files you’ve written.  
OLDPLACE: directory where personal files were located in earlier versions of Stata. 
[Ado-files you have written just this instant or just for this project are located in (.).] 
 
 
Working Directory 
The working directory is where Stata looks for your do-files and datasets and where Stata will save the 
files you create, such as new logs or datasets. If you type a command to load a dataset and do not specify 
a directory, Stata looks in the working directory. For example… 
 
. use SOC561.dta, clear 
  Stata will look in the working directory.  
 
. use "/Users/hannahandrews/Documents/Grad_Courses/(6)16SP_SOC 561 
Data Management/SOC561-NHANES_DBN05-06.dta", clear  
 Stata will look in the directory specified in the command.  
 
. do Andrews_HW2.do 
 Stata will look in the working directory.  
 
. do "/Users/hannahandrews/Documents/Grad_Courses/(6)16SP_SOC 561 
Data Management/Andrews_HW2.do” 
 Stata will look in the specified directory for the do-file.  
 
. cd 
 This command shows you your current working directory. Use the command pwd in Mac OS X 
 or Unix. This command can also be used to change directories by typing out path for the desired 
 directory. You can change directories using menu options as well: File>Change Working 
 Directory 
 
 
Working on a network 
1) Working directories  

Long (2009) suggests opening every working session with cd or pwd to determine your working 
directory. Note whether the directory is private (associated with your name) or public. If the working 
directory is public, others may write over your files.  
2) Installing ado-files  

Usually when working on a network, you will not have permission to write files to Stata’s 
system directories (this protects against intentional/accidental changes to how Stata works). Besides 
being a protective measure, this also prevents you from being able to download or update ado-files. If 
you try to install a new package but do not have permission, you will receive the error message… 
  
. cannot write in directory ~/Library/Application 
Support/Stata/ado/stbplus/ 
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Solution: Tell Stata to install the files to a folder that is not restricted.  
 
Step 1: Check what the current PLUS directory is using sysdir 
 
Step 2: Create a directory that will become the new PLUS directory. This can be done using the file 
manager or the mkdir command. For example, to create L:\adoplus (a drive on which you can 
read and write files):  
. mkdir L:\adoplus 
 
Step 3: Use sysdir with the set option to redefine the location of the PLUS directory. 
. sysdir set PLUS L:\adoplus 
 
Step 4: Run sysdir again to verify that the PLUS directory has been changed.  
 
 
Customizing Stata 
 
Fonts and window locations  
To change fonts in Stata, right click the window whose font you want to change. Select Fonts, then 
choose the desired font, style, and/or text size.  
Change the size of windows within the Stata interface by clicking and dragging them to the desired size. 
To save whatever changes you make as the default settings for Stata, go to menu options: 
Edit>Preferences>Manage Preferences> Save Preference.  
 
 
Commands to change preferences 
To change some preferences, a set command must be used.  
For example, if you wanted to change the line width for the interface and log files… 
. set linesize # 
 
or if you wanted to set the log type to always be either text or smcl… 
. set logtype text|smcl 
 
See the Stata manual for a full list of preferences to be set with the set command (the Stata manual is 
discussed under the Getting Help section).  
 
You can use the query command to view your current system parameters, including memory settings, 
output settings, interface settings, graphics settings, efficiency settings, network settings, update settings, 
trace (program debugging) settings, mata settings, and others.  
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Options that can be set permanently  
For some set commands, you can specify the permanently option at the end of a set command 
following a comma to tell Stata to remember the command the next time you run Stata.  
 
For example, if you wanted to changed the default confidence level for confidence intervals for all 
commands that report confidence intervals…  
. set level #, permanently  
 
or if you wanted to set the maximum number of variables allowed…  
. set maxvar #, permanently  
 
Other preferences that can be changed permanently include the format used for log files, scrollback 
buffer in the results window, size of matrices, and memory. To determine whether a setting can be set 
permanently, consult the Stata manual. 
 
 
Options that need to be set each session  
Some set commands, such as line size, need to be set each session. You can create a do-file with your 
preferences to be run every time you open Stata. Such do-files are named profile.do. Stata will look 
for the file profile.do when it is launched starting with the system directory (where Stata is 
installed), then in the current working directory, then on your path, then in your home directory (as 
defined by your user profile on your computer), and then on the ado-path. When Stata finds 
profile.do it will automatically run it. Write your profile.do like any other do-file.  
 
To manually run the profile (e.g. if you’re working on a network) use the command…  
. do profile.do  
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Ado-Files  
 
An ado-file is a text file that defines a Stata command that was not built-in when Stata was installed. 
Ado-files can be downloaded from various sources such as Stata Journal, the Stata forum Statalist 
(www.statalist.org), or the Boston College Statistical Software Components (SSC) archive. For a video 
guide on installing ado-files, please see https://www.youtube.com/watch?v=iP-
8ne6j9ZI&feature=youtu.be. When you run a command that is not built-in to Stata, Stata checks the 
system directory for matching ado-files. Once a matching ado-file is found, Stata executes the ado-file 
so that the results appear no different than they would for a built-in command. If you are unsure whether 
a command is built in or an ado-file, you can use the which command. This command will also tell you 
where the file is stored if it is an ado-file. For example, estout is an ado-file to create regression 
tables… 
 

 
 
Summarize is a built in command…  
 

 
 
How to view an ado-file  
There are two ways to view ado-files. The type command displays the contents of a file in the results 
window… 
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The viewsource command searches for a file along the ado directories and displays the file in the 
viewer. Viewsource can be used to view any text file you working with, including program files, help 
files, text data files, do-files, and log files. For example, if I type… 
 
. viewsource estout.ado 
 
… a window pops up with the ado-file for the estout package.  

  
 
 
You can also use viewsource to open help files associated with ado-files (most ado-files come with a 
help file). When displayed using this command, Stata shows the SMCL (Stata Markup and Control 
Language) commands. You may find this helpful if you are trying to write or format your own help file. 
Help files are usually named after the associated command and end in .hlp. Thus, to find the help file 
associated with the estout package, I would type…  
. viewsource estout.hlp 
 
 
 
 
 
 
 
 



	   8	  

Again, the text appears in a pop up window.  
 

 
 
Note: The Viewer is not an editor, so you will not be able to make changes to files if you access them 
this way.  
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Finding an editor 
If you did want to find an editor for ado-files, you can use the command…  
. findit adoedit.  
 
A pop up window will give you various options for editors to download.  

 
 
Notably, findit conducts a general web search. For a more focused search that lists Stata sources 
first, use net search.  
 
 
Checking for updates 
To check for updates for ado-files you’ve downloaded, used the command adoupdate. 
 
. adoupdate 
(note: adoupdate updates user-written files; type -update- to check 
for 
updates to official Stata) 
 
Checking status of installed packages... 
 
[1] tab_chi at http://fmwww.bc.edu/repec/bocode/t: 
package has been updated on server 
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[2] estout at http://fmwww.bc.edu/RePEc/bocode/e: 
package has been updated on server 
 
[3] spost9_ado at http://www.indiana.edu/~jslsoc/stata: 
installed package is up to date 
 
[4] sg97_4 at http://www.stata-journal.com/software/sj12-1: 
package has been updated on server 
 
[5] snp3 at http://www.stata.com/stb/stb3: 
installed package is up to date 
 
[6] nbvargr at http://www.ats.ucla.edu/stat/stata/ado/analysis: 
installed package is up to date 
 
[7] st0081 at http://www.stata-journal.com/software/sj5-1: 
installed package is up to date 
 
Packages that need to be updated are... 
 
[1] tab_chi      -- 'TAB_CHI': modules for tabulation of multiple 
variables in Stata 8.2 or better 
[2] estout       -- 'ESTOUT': module to make regression tables 
[4] sg97_4       -- SJ12-1 sg97_4.  A new system for formatting 
estimation... 
 
Recommendation:  type 
adoupdate, update 
 
Stata checks updates for each ado-file installed on the computer, then suggests available updates to 
install. Click on  adoupdate, update to update installed ado-files.  
 
To look for official updates to StataCorp distributed ado-files, use the command update query.  
 
 
Getting Help 
 
If you find yourself stuck in Stata, there are several resources to turn to for help. Here I will present a 
few resources in more or less the order I would recommend utilizing them.  
 
(1) help advice  
The help advice command will be most useful to true Stata newbies. It will take you to a help window 
with advice on finding help.  
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(2) help [command] 
This command will take you to Stata’s help files, an abbreviated version of the Stata manuals that come 
with Stata when it is installed. If I needed help with graphs, I would type… 
 
. help graph  
 
And this window would pop up.  
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(3) The Stata Manuals (.pdf documentation)  
As stated previously, the help command takes you to an abbreviated version of the Stata manuals. To 
access the Stata manuals, you can click on the link under the Title section of the help window. If after 
looking at the help window for graph I decided I needed more information, I would click on [G-2] 
graph which takes me to the graph section of the Stata manuals.  
 

 
 
You can also access the Stata manuals through menu options: Help>PDF Documentation. Once you 
have the Stata manual open, use the panel on the left side of the pdf viewer to navigate between subjects. 
Stata manual is compatible with the Adobe Acrobat Reader.   
 
(4) search 
Search searches a keyword database and the internet for Stata materials related to your inquiry. It is 
not case-sensitive or sensitive to special characters. You can search multiple words at a time. There are 
several options you can add to search to make your search more specific. 
 
To limit your search to Stata Journal articles… 
. search word, sj  
 
To limit your search to Stata manual entries… 
. search word, manual  
 
 
 
 



	   13	  

Other search options you might include after the comma include… 
 
all default search option; searches the local keyword database and net materials; displays in 

Viewer. 
 
local  searches the local keyword database; displays in Viewer.   
 
net  equivalent to the net search command; displaus in Viewer.  
 
author searches based on author’s name instead of keywords; searches local keyword database; 

displays in Results.  
 
entry searches entry IDs instead of keywords; displays in Results.  
 
exact will not match abbreviations; searches local keyword database and net materials; displays 

in Results.  
 
faq searches only FAQs posted on the Stata website; searches local keyword database; 

displays in Results.  
 
or will list entries if any (as opposed to all) of the words searched are associated with the 

entry; search local keyword database; displays in Results.  
 
(5) Searching the web 
Most questions can be answered by simply googling your problem. Some especially helpful websites 
include Stata Forums (if you have a question chances are someone else already asked!), the Social 
Science Computing Cooperative (SSCC) at UW Madison (www.ssc.wisc.edu/sscc/), and the Insitute for 
Digital Research and Education (IDRE) at UCLA’s website (www.ats.ucla.edu/stat/stata).   
 
(7)  LAST RESORT: Posting to Stata Forums 
IF you cannot find anything using the help and/or search commands, the pdf documentation, Stata 
Forums or any other website, THEN consider posting to Stata Forums. But be warned- this internet 
community takes its netiquette seriously. Before posting, check the Stata Forum FAQ for advice on 
posting (www.statalist.org/forums/help#technical). The FAQ addresses what you should do before you 
post (more or less the first 6 options listed here), how to format a post in a way that will get you 
answers, and expectations for posting/commenting behavior.   
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